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사용자 설명서 정보
이 사용자 설명서는 UMPC(Ultra Movile PC)의 다양한 구성 요소에 관한 정보를 제공
합니다.

설명서 구성 정보

•	 1 장: UMPC 시작하기

	 UMPC의 기능에 대해 설명합니다.

•	 2 장: UMPC 사용하기

	 UMPC 사용을 위한 지시사항을 제공합니다.

•	 3 장: 멀티미디어 기능

	 UMPC의 멀티미디어 기능에 대한 정보를 제공합니다.

•	 4 장: 연결

	 UMPC의 연결 기능에 대한 정보를 제공합니다.

•	 문제 해결

	 UMPC 사용 도중 발생할 수 있는 문제의 해결 방법을 제공합니다.

•	 부록

	 UMPC 사용을 위한 추가 정보를 제공합니다.



��

설명서 참고 사항
본 설명서에 사용된 아래의 심볼을 참고하여 특정 작업이 올바르게 수행되고 있는지를 
확인할 수 있습니다. 

		  위험/경고: 작업 도중 사용자의 신체에 해가 될수 있는 가능성을 예	
	 방하고, 작업을 완료하기 위한 정보 

		  주의: 구성 요소에 손상을 줄 수 있는 가능성을 예방하고, 작업을 	
	 완료하기 위한 정보 

		  참고: 작업을 완료하도록 도와주는 팁 또는 추가 정보

		  중요: 작업을 완료하기 위해 반드시 따라야 하는 지시사항 
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입력 전력: UMPC 하판부에 붙어 
있는 레이블에 기재된 전력값과 
전원 어댑터의 전력이 일치하는
지 확인해 주십시오.

다음 그림과 같은 마크가 표시된 
전기전자 제품은 해당 국가의 전
자 제품 관련 규정을 준수하여 폐
기해 주십시오.

안전 정보

중요!  제품을 청소하기 전에 AC 전원과 배터리 팩을 분리해 주십시오. 비마모성 세제
액을 따뜻한 물에 풀어 넣고, 이를 깨끗한 섬유 스폰지 또는 세무천에 몇 방울 적신셔
서 UMPC를 닦은 후, 마른 천으로 남은 물기를 제거해 주십시오.

액체, 비, 습기 등에 노출시키지 
마십시오.

더럽거나 먼지가 많은 환경에 노
출시키지 마시고, 가스가 새는 동
안은 작동시키지 마십시오.

안전 작동 온도: 본 UMPC는 5°C 
(41°F)에서 35°C (95°F) 사이의 
온도에 최적화 되어 작동합니다.

배터리 안전 경고:

배터리를 불에 넣지 마십시오.

전기적 충격을 가하지 마십시오.

배터리를 분해하지 마십시오.

강한 자기나 전기장에 노출시키
지 마십시오.

평평하지 않거나 불안정한 장소
에 놓지 마십시오. 만일 외관이 
손상되었다면 수리를 요청해 주
십시오.

UMPC 위에 물건을 올려놓거나 
떨어뜨리지 마십시오. UMPC 안
에 이물질을 넣지 마십시오.

디스플레이 패널을 긁지 마십시
오. UMPC를 긁거나 통풍구 내부
로 들어갈 수 있는 작은 물건을 
UMPC와 함께 두지 마십시오. 

UMPC 사용시 무릎 위에 올려 놓
거나, 신체 일부분과 접촉하지 
마십시오. 열 노출에 의해 화상
을 입거나, 불편함을 느낄 수 있
습니다.

가방과 같이 공기 순환이 원활히 
이뤄지지 않는 곳에 UMPC의 전
원을 켠채로 두지 마십시오.
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휴대시 주의사항  
UMPC를 운반할 경우 전원을 끈 후, 커넥터의 손상을 방지하기 위해 모든 주변장치
를 분리해 주십시오. 전원을 켠 채로 이동할 경우 하드디스크 드라이브 헤드로 인해 
하드디스크 표면이 손상을 입을 수 있습니다. 그러므로 전원이 켜져 있는 동안에는 
UMPC의 이동을 삼가해 주십시오. 키보드와 디스플레이 패널을 보호하기 위해 상판의 
덮개가 닫혀 있는지 확인해 주십시오.

UMPC 보호

제품에 포함된 가방을 이용해 먼지, 물, 충격, 긁힘으로부터 UMPC를 보호해 주십시오.

배터리 충전  

장거리 여행 등의 목적으로 배터리를 이용해 UMPC를 사용할 경우 배터리 팩과 여분의 
배터리 팩을 충전시켜 준비해 주십시오. 전원 어댑터를 컴퓨터에 연결하여 UMPC를 사
용하는 도중에도 배터리 팩의 충전이 가능합니다. UMPC를 사용하는 동안 배터리 팩을 
충전할 경우 충전 시간이 다소 길어집니다. 

비행기내 이용시 주의사항  

비행기내에서 UMPC를 사용하고자 할 경우 항공사 측에문의해 주십시오. 대부분의 항
공사는 전자 기기 사용에 관한 규정을 정해 놓았으며, 이착륙시를 제외한 기내에서의 
사용을 허용하고 있습니다.

주의: 공항 내에는 다음과 같은 세 종류의 공항 보안 검색 장치가 존재합니다. X-레
이 기기(수화물 벨트 위의 물품에 사용), 자기 탐지기(보안 검색대를 통과하지 않는 입
출국자에게 사용), 자기 판독기(손에 들고 사람이나 개인 소지품에 사용). UMPC의 
경우 공항 내에 있는 X-레이 기기를 통해 UMPC 및 디스켓의 검색을 받아 주십시오. 
UMPC 및 디스켓이 자기 탐지기나 자기 판독기에 의해 검색을 받지 않도록 주의해 주
십시오.



1010

참고: 위의 항목 중 하나라도 손상 또는 유실되어 있을 경우 구입처에 즉시 문의해 주
십시오.

패키지 구성

기본 항목
구입하신 UMPC 패키지가 아래의 항목들을 포함하고 있는지 확인해 주십시오:

기본 항목

•  R50A UMPC •  보호 가방

•  미니 USB 오디오 케이블 •   디지펜 스타일러스

•  10핀 VGA 출력 케이블 •  사용자 설명서  

•  화면 보호기 •  빠른 시작 안내 설명서

•  어댑터 •  드라이버 CD

•  어댑터 플러그 •  복구 DVD

•  손목 스트랩 •  이어폰

•  USB 키보드 •  이어폰 플러그

추가 항목

•  차량용 충전기 •  TV 외장 안테나

•  차량용 지지대 •  차량용 TV 외장 안테나

•  GPS 안테나 •  USB 방식의 이동식 ODD

•  Bluetooth 마우스 •  ODD USB 케이블

•  USB 포트 바 (ACP45) •  ODD 충전기

NOTE:	 추가 항목의 경우 기본 패키지에 포함되어 있지 않으며, 사용자 개인이 별도
로 구입해야 합니다.

추가 항목
UMPC에서 추가로 아래 항목들을 함께 이용할 수 있습니다:
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특별 기능

제품 주요 기능

성능을 겸비한 이동성 

ASUS R50A는 강력한 연산 기능과 함께 보안 기능을 제공합니다. 또한 소프트웨어 및 
하드웨어 솔루션 모두를 보호하는 편리한 보안 기능이 적용되어 이동성과 성능간의 조
화가 완벽하게 이루어져 있습니다.

휴대 가능한 초경량 설계

ASUS R50A은 휴대 가능한 초경량 설계와 함께 컴퓨팅, 멀티미디어, 폭넓은 확장 기능
이 탑재되었습니다. R50A는 인터넷 서핑, 무선 네트워크 연결, 위치 추적 및 기타 일반 
데스크탑 PC에서 가능한 모든 작업 수행을 위한 최신 기술을 포함하고 있습니다.

확장성

ASUS R50A에 내장된 Bluetooth 2.0 EDR ( Enhanced Data Rate)과 WLAN 802.11 
a/b/g은 고속의 인터넷과 무선 네트워크 연결 기능을 사용자에게 제공합니다.

GPS 네비게이션

ASUS R50A는 내장된 GPS 송수신기를 통해 사용자에게 편리한 여행 가이드를 제공합
니다. 이를 이용해 사용자는 가고자 하는 장소로의 방향과 해당 도로에 대한 정보를 편
리하게 얻을 수 있습니다.

강력한 보안 관리 

ASUS R50A는 소프트웨어 및 하드웨어의 보안 요구를 동시에 만족하는 종합적인 데이
터 보호 솔루션을 제공합니다.

보호된 컴퓨팅 기능은 인증된 사용자에게만 접근을 허용하는 강력한 지문 인증 기능으
로부터 시작됩니다. 보다 정확한 탐독 능력을 위해 전자 이미지 센서는 기타 일반 표피 
층을 통과하여 피부의 살아있는 층으로부터 지문의 성향을 스캔합니다.
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ASUS만의 ASPM (Security Protect Management)은 장치 및 네트워크로의 접속을 보
호합니다. 사용자는 보안의 신뢰성을 떨어뜨리지 않고도 SSO(Single Sign On)를 이용
한 한번의 로그인을 통해 서로 다른 보안 수준을 요구하는 다양한 인증 요구사항을 설
정하도록 선택할 수 있습니다. 

직관적인 사용의 용이성 

ASUS R50A는 Windows® Vista Tablet PC Edition의 Touch Pack 소프트웨어와 인체
공학적 설계를 갖춘 하드웨어 인터페이스를 포함하고 있습니다. 전면 패널의 양 쪽에 
놓여 있는 기능 키를 이용해 조이스틱, 탐색 키, 화면 상의 키패드를 포함한 제어 키의 
전체 기능을 편리하게 이용할 수 있습니다.

쉬우면서도 안전한 디지털 데이터 전송 

ASUS R50A는 Secure Digital 미디어 슬롯을 통합하고 있습니다. SD 카드와 슬롯을 이
용해 다른 장치 및 사용자와 편리하게 파일을 빠르게 공유할 수 있도록 해 줍니다.



1
• 올바른 UMPC 사용 자세

• UMPC 기본 구성

• UMPC 사용 준비

• UMPC 시작

이 장에서

UMPC 
시작하기
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UMPC 사용을 위한 올바른 자세
UMPC를 사용할 경우 손목, 손, 관절 또는 근육의 긴장을 방지하기 위해 필요한 올바른 
자세를 유지해야 합니다. 이 장에서는 UMPC를 이용하는 동안 발생할 지도 모를 신체
적 불편함이나 상해의 위험성을 피하기 위한 팁을 제공합니다.

올바른 자세 유지하기
•	 UMPC를  장시간 무릎 위에 올려놓거나 신체에 가까이 두지 마십시오.

•	 UMPC를 조명이 충분하고, 환기가 잘 되는 환경에서 사용해 주십시오.

•	 UMPC의 화면을 청결한 상태로 유지시켜 주십시오.

•	 UMPC를 이용해 통화를 걸거나 수신하려면 별도의 헤드셋을 이용해 주십시오.

•	 UMPC를 장시간 이용해야 할 경우:

	 •	 UMPC의 화면 또는 가상 키보드 대신에 외장 키보드를 연결해 주십시오.

, 	 •	 UMPC의 타색 버튼 또는 조이스틱 대신에 외장 마우스를 사용해 주십시오.

	 •	 UMPC를 통합 도킹 스테이션과 연결하고, 조절하여 UMPC를 시야각과 맞춰 주	
	 십시오.

	 •	 UMPC를 사용하는 도중 일정 시간마다 지속적으로 휴식을 취해 주십시오.  

참고: 

	 •	 외장 키보드 또는 마우스를 UMPC에 연결하기 위한 정보는 1장 UMPC 	
		  사용 준비 부분을 참고해 주십시오. 
 

	 •	 통합 도킹 스테이션은 사용자의 UMPC 패키지에 포함되어 있지 않으	
		  며, 사용자가 별도로 구매하셔야 합니다.
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UMPC 사용 준비

1 2

3

4

5

6

7

8

9

10

11

12

13

14

전면부 기능

기능

1 디스플레이 패널

5.6인치 활성 매트릭스의 1024 x 600 해상도를 지원하는 TFT LCD 화면은 데스크탑 
모니터 수준의 뛰어난 화질을 제공합니다.

2 전면 카메라 렌즈

0.3 메가 픽셀의 내장 카메라를 이용해 화상 회의 및 기타 대화형 애플리케이션에 이
용할 수 있습니다.

3 조이스틱

데스크탑 마우스와 같은 기능을 하는 포인팅 장치입니다.



1616

기능

4 상태 표시등

배터리, 드라이브 동작, WLAN, Bluetooth의 상태를 확인할 수 있습니다. LED는 아
래와 같은 정보를 보여줍니다: 

전원

• 흰색: UMPC의 전원이 켜진 상태

• 흰색의 깜박임: UMPC가 절전/대기 상태

• 꺼짐: UMPC의 전원이 꺼져 있거나 하이버네이션 상태

배터리

• 빨간색: 배터리 충전 중

• 빨간색의 깜박임: 배터리 용량이 10% 미만인 상태

• 꺼짐: 배터리가 완전히 충전된 상태

HDD

• 흰색: UMPC가 하드디스크 드라이브에 접속 중

• 흰색의 깜박임: UMPC가 읽기/쓰기 모드에 있음.

메세지

• 켜짐: 읽지 않은 수신 메시지가 존재함

WLAN

• 켜짐: 내장 무선 LAN (WLAN)이 활성화됨

Bluetooth

• 켜짐: 내장 Bluetooth 기능이 활성화됨

3G

• 켜짐: 3G 기능이 활성화됨

GPS

• 켜짐: GPS 기능이 활성화됨

5 지문 센서

내장된 지문 센서를 이용해 사용자의 지문을 신분 식별을 위한 키로 사용할 수 있습
니다.

6 5 Way 탐색 버튼

방향키 (왼쪽, 오른쪽, 위, 아래) 및 엔터키는 키보드의 기능과 같습니다.

7 내장 마이크

내장된 모노 마이크를 화상 회의, 음성 나래이션 또는 간단한 오디오 녹음에 이용할 
수 있습니다.
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기능

8 절전 모드 버튼

이 버튼을 누르면 UMPC를 절전 모드로 전환할 수 있습니다. 전원 스위치를 아래로 
밀면 UMPC는 절전 모드로부터 복구됩니다.

9 로그인 버튼

로그인 버튼은 [Ctrl + Alt +Del]와 같은 키보드 조합을 운영체제에 전송해 Windows 
보안은 로그인/아웃, 잠금, 종료, 작업 관리자 실행, 비밀번호 변경 등을 보여줍니다. 
이 특별한 로그인 기능은 SAS (Secure Attention Sequence)로도 알려져 있습니다.

10 UMPC 설정 버튼

UMPC의 밝기, 볼륨, 해상도와 전력 모드를 설정할 수 있습니다.

11 Windows® Media Center 버튼

비디오 클립, 음악 파일 또는 영화와 같은 미디어 파일을 감상 또는 재생할 수 있는 
Windows® Media Center를 실행합니다.

12 왼쪽 키

이 키는 마우스의 왼쪽 버튼 클릭과 같은 효과를 가집니다.

13 오른쪽 키

이 키는 마우스의 오른쪽 버튼 클릭과 같은 효과를 가집니다.

14 GPS 모듈 위치

이 부분에 GPS 모듈이 위치해 있습니다.
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우측면 기능

기능

1 손목 스트랩 구멍

제공된 손목 스트랩을 이 구멍에 매달아 휴대 중 실수로 UMPC를 떨어지는 일을 예
방할 수 있습니다.

2 VGA 포트

VGA 출력 케이블을 이용해 UMPC의 이 포트와 모니터를 연결해 주십시오..

3 배터리 잠금 장치

배터리를 움직이지 않도록 고정해 주십시오. 누른채로 위로 올린 후에 후면 커버를 
아래로 밀면 배터리를 분리 가능합니다.

4 USB 포트 (2.0)

키보드, 포인팅 장치, 하드디스크 드라이브, 프린터 또는 스캐너와 같은 USB 2.0 장
치를 이 포트에 연결해 주십시오.

2 3 41
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좌측면 기능

기능

1 전원 스위치

UMPC의 전원을 켜고 끄거나 절전/대기, 또는 하이버이션 모드로 전환 가능합니다.

2 소형 USB 포트

외장 USB 장치를 이 포트에 연결해 주십시오.

3 TV 튜너 포트

TV 안테나를 이 포트에 연결해 주십시오. 
 
참고: TV 안테나는 패키지에 포함되어 있지 않으며 별도로 구매하셔야 합니다.

4 MicroSD 슬롯

microSD 카드를 슬롯에 넣어 주십시오.

1 2

3 4
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상판부 기능

1 2 3 4 5 2 6

7

기능

1 카메라 버튼

카메라 애플리케이션을 실행하고, 사진 촬영 또는 비디오 클립의 제작이 가능합니다.

2 스피커 시스템

내장 스피커 시스템을 통해 풍부하고 화려한 고품질의 스테레오 사운드 감상이 가능
합니다.

3 전원 (DC) 포트

AC 어댑터를 이 포트에 연결하여 UMPC에 외장 전원을 공급할 수 있습니다.

4 헤드폰 잭

R50A 헤드폰을 이 포트에 연결해 주십시오.

5 HOLD 키

이 키를 왼쪽으로 이동하면 UMPC의 LCD와 버튼을 비활성화합니다.

6 GPS 포트

외장 GPS 안테나를 부착하여 보다 나은 신호 수신 성능을 얻을 수 있습니다.

7 스타일러스

일반 데스크탑 마우스의 왼쪽 클릭, 더블 클릭, 오른쪽 클릭 기능과 같이 UMPC의 마
우스처럼 동작합니다.

중요!	 UL (Underwriters Laboratories Inc.)은 GPS (Global Positioning 
System) 하드웨어, 운영체제 또는 이 제품의 기타 특성에 대한 성능 또는 안정성을 검
사하지 않습니다. UL은 안전을 위한 UL 표준에 기술된 화재, 충격 또는 재해에 대해서
만 검사합니다. UL60950-1 인증은 GPS 하드웨어 및 운영 소프트웨어에 대한 성능 
및 안정성에 대해 보장하지 않습니다. UL은 이 장치의 모든 GPS 관련 기능의 성능과 
안정성에 관련된 모든 부분에 대해서 표현, 보증 또는 인증하지 않습니다.
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하판부 기능

기능

1 손목 스트랩 구멍

제공된 손목 스트랩을 이 구멍에 매달아 휴대 중 실수로 UMPC를 떨어지는 일을 예
방할 수 있습니다.

2 리셋 버튼

클립 또는 볼편과 같은 뾰족한 물체를 이 곳에 넣어 누르면 UMPC의 리셋이 가능합
니다.

3 공기 통풍구

차가운 공기를 유입하고, 뜨거운 공기를 시스템 밖으로 배출하하는 기능을 합니다.

1 32
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후면부 기능

1 2

기능

1 배터리 팩

배터리 팩은 UMPC에 전원을 공급합니다. 배터리를 교체하려면 AC 어댑터를 이용해
UMPC를 외장 전원과 연결해 주십시오.

2 카메라 렌즈

2.0 메가 픽셀의 자동 포커스 기능이 내장된 카메라를 이용해 사진 또는 비디오를 촬
영할 수 있습니다.
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UMPC 사용 준비
UMPC을 처음으로 사용하기 전에 배터리를 완전히 충전해 주십시오.

배터리 팩 충전
UMPC 패키지는 배터리 팩 충전과 UMPC로의 전원 공급이 가능한 통합 AC-DC 어댑
터를 포함하고 있습니다. 사용자께서는 스위치 설정이나 전원 컨버터를 사용하지 않고
도 어댑터를 100-120V 또는 220V-240V 전원 콘센트에 연결하여 사용할 수 있습니다.

배터리 팩 충전:

1.	 어댑터 플러그를 AC 어댑터에 연결해 주십시오.

2.	 어댑터를 UMPC의 상판부에 위치한 DC 포트에 연결해 주십시오.

3.	 어댑터를 전원 콘센트에 연결해 주십시오.

참고:	  
 
	 •	 UMPC 패키지에 포함된 AC/DC 어댑터만을 사용해 주십시오. 
 
	 •	 다음 페이지의 AC 어댑터 부분을 참고하여 해당 지역에서 사용 가능한 전원 플	
		  러그 방식에 적용되는 AC 어댑터 방식을 결정해 주십시오.

경고:   어댑터는 사용시 뜨거워질 수 있으므로, 신체에 가까이 두지 마십시오.

PUSH

1

2 3
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분류 국가/지역 전압 사이클 소켓

아시아 한국 100.220 60 (A)(C)(E)

일본 100 50 (A)

홍콩 200 50 (D)(F)

중국(대륙) 220 50 (A)(C)(D)(E)(F)

필리핀 220-230 60 (A)(C)(E)

타이 220 50 (C)(D)

싱가폴 230 50 (B)(C)(D)

인도 230 50 (B)(C)

오세아니아 오스트레일리아 240 50 (E)

뉴질랜드 230 50 (E)

북 아메리카 미국 120 60 (A)

하와이 120 60 (A)

괌, 사이판 120 60 (A)

캐나다 120 60 (A)

중앙 아메리카 멕시코 127 60 (A)

유럽 영국 240 50 (D)

프랑스 127.220 50 (D)

이탈리아 220 50 (C)

스페인 127.220 50 (A)(C)

그리스 220 50 (C)

스웨덴 220 50 (C)

오스트리아 220 50 (C)

독일 220 50 (C)

네덜란드 220 50 (C)

노르웨이, 스웨덴 220 50 (C)

러시아 127.220 50 (A)(C)

AC 어댑터

아래는 특정 국가에서 사용되는 다양한 전원 플러그 및 소켓과 호환되는 AC 어댑터의 
목록입니다. 

A

B

C

D

E

F
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microSD 카드 설치/제거
UMPC에는 microSD 카드 슬롯이 포함되어 있습니다.  microSD 카드는 사용자에게 파
일을 위한 추가 저장 공간을 제공해 줍니다.

microSD 카드 설치:

1.	 UMPC의 좌측면에 위치한 microSD 카드 
슬롯이 보이도록 해 주십시오.

2.	 슬롯 커버를 열어 주십시오.

3.	 금색 선이 아래로 가도록 하여 MicroSD를 
슬롯에 넣어 주십시오.

4.	 슬롯 커버를 닫아 주십시오.

microSD 카드 제거:

1.	 슬롯 커버를 열어 주십시오.

2.	 카드를 살짝 눌러 꺼낸 후에 microSD 카드를 슬롯에서 제거해 주십시오.

3.	 슬롯 커버를 닫아 주십시오.
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외장 접이식 USB 키보드 설치:

외장 접이식 USB 키보드 설치

3.	 가운데의 윗 부분에 위치한 Lock(잠금)/Unlock(잠금 해제) 래치가 보이도록 한 후
에 래치를 왼쪽으로 밀어 키보드를 개폐 상태로 고정(Lock)해 주십시오.

LOCK UNLOCK

1.	 래치를 아래쪽으로 밀어 USB 키보드
의 잠금 상태를 해제해 주십시오.

2.	 부드럽게 들어올려 키보드를 열어 주
십시오.
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5.	 소형 USB 케이블을 USB 키보드의 
소형 USB 포트에 연결하고, 케이블
의 다른 한 쪽 끝을 UMPC의 소형 
USB 포트에 연결해 주십시오.

4.	 소형 USB 케이블의 양 쪽 끝을 조심스
럽게 당겨 확장시켜 주십시오.
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외장 모니터 연결
UMPC에 외장 모니터를 연결할 수 있습니다. 외장 모니터의 화면은 UMPC의 LCD 모
니터와 동기화됩니다. 이 방식으로 LCD 모니터의 수명을 연장할 수 있습니다.

UMPC에 외장 모니터 연결:

1.	 UMPC의 전원을 켜 주십시오.

2.	 외장 모니터 케이블의 한 쪽 끝을 UMPC의 포트에 연결하고, 다른 한 쪽 끝을 외장 
모니터의 15핀 D-커넥터에 연결해 주십시오.

주의: UMPC를 외장 모니터와 연결할 경우 너무 힘을 주지 마십시오. 외장 모니터의 
플러그는 한 방향으로만 설치가 가능합니다.
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UMPC의 전원을 켠 후에 화면 표시 전환:

1.	 UMPC의 전원을 켜 주십시오.

2.	 다음의 디스플레이 모드 중 하나를 선택해 주십시오:

	 a.	 UMPC 및 외장 모니터 모두 동일한 화면 사용 (기본값)

	 b.	 UMPC와 외장 모니터에 서로 다른 화면 표시.

	 c.	 외장 모니터에만 화면 표시.

3.	 OK를 클릭해 주십시오

화면 표시 수동으로 전환:

1.  > Windows Media Center를 클릭해 주십시오.

2. Connect to monitor(모니터에 연결)을 선택해 주십시오.

3. 모드를 선택해 주십시오.

4. OK를 클릭해 주십시오.

디스플레이 해상도 조절:

1. 바탕화면의 빈 공간에 마우스 오른쪽 버튼을 클릭하고, Contents > Personalize를 
클릭해 주십시오.

2. 보조 모니터를 선택해 주십시오. 디스플레이 해상도를 최고 값으로 선택해 주십시
오.

3. Apply을 클릭해 주십시오.
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외장 헤드폰 연결
이 UMPC는 외장 헤드폰 및 스피커 연결을 위한 Line 출력 포트를 포함하고 있습니다.

UMPC에 외장 헤드폰 연결:

1.	 헤드폰을 UMPC의 헤드폰 포트에 연결해 주십시오.

1.	 UMPC 및 외장 헤드폰에서 볼륨 수준을 조절해 주십시오.

외장 마우스 연결 (옵션)
이 UMPC는 여러 USB 포트를 포함하여 USB 키보드/마우스와 같은 장치의 연결을 지
원합니다.

외장 마우스 연결:

•	 USB 마우스의 USB 플러그를 UMPC의 USB 포트에 연결해 주십시오.

주의: USB 키보드/마우스를 UMPC의 USB 포트에 연결할 때 무리한 힘을 주지 마십
시오. USB 플러그는 한 방향으로만 설치가 가능합니다.
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중요:  
	 •	 PortBar를 사용할 경우 AC 전원 어댑터를 이용해 주십시오. UMPC가 배터리 	
		  모드인 경우 PortBar를 사용할 수 없습니다.  
 
	 •	 UMPC와 PortBar에서 모든 포트를 사용 중인 경우 두 개의 AC 전원 어댑터	
		  (UMPC와 PortBar) 모두를 사용해 주시길 권장합니다.  
 
	 •	 PortBar를 연결하면 UMPC의 LAN 포트는 비활성화됩니다.

PortBar 연결 (옵션)
이 외장 PortBar 옵션은 D-Sub 포트, S/PDIF 출력 포트, LAN (RJ-45) 포트 및 USB 
2.0/1.1 포트를 포함하고 있습니다. 이 외장 PortBar를 이용해 키보드, 마우스, CRT 모
니터와 같은 주변장치를 빠르게 UMPC에 연결할 수 있습니다.

참고: PortBar는 별도로 구매해야 하며, UMPC 패키지에 포함되어 있지 않습니다. 

UP

DC 5V
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외장 ODD 연결 (옵션)

외장 ODD 연결:

1	 ODD USB 케이블의 한 쪽 끝을 ODD 후면부에 위치한 소형 USB 포트에 연결하고, 
다른 한 쪽 끝을 UMPC의 USB 포트에 연결해 주십시오.

2.	 어댑터 플러그를 ODD AC 어댑터에 연결해 주십시오.

3.	 어댑터를 ODD의 DC 포트에 연결해 주십시오.

4.	 ODD 어댑터를 전원 콘센트에 연결해 주십시오.   

PUSH
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외장 TV 안테나 연결 (옵션)
UMPC를 가정 또는 차량 내에서 사용 가능한 TV 안테나와 연결해 주십시오.

외장 TV 안테나 연결:

1.	 TV 안테나 케이블을 UMPC의 좌측면에 위치한 안테나 포트에 연결해 주십시오.

2.	 최적의 신호 수신을 위해 안테나의 방향과 위치를 조절해 주십시오.

3.	  > 모든 프로그램 > TVB-T Mobility > TVB-T Mobility를 클릭하여 TV 안테나 애
플리케이션을 실행해 주십시오.

4.	 채널 선택, 볼륨 조절 또는 비디오 녹화가 가능합니다.
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UMPC 시작
UMPC 전원 켜기
일반적인 데스크탑 PC와 같이 UMPC 또한 시작시 POST(Power-On Self Test)라고 
불리는 진단 테스트를 자동으로 실행합니다. POST가 완료된 후, UMPC가 부팅되며 
Windows® 운영체제가 자동으로 시작됩니다.

UMPC 전원 켜기:

1.	 UMPC의 좌측면에 위치한 전원 스위치가 
보이도록 해 주십시오.

2.	 UMPC의 스위치를 아래로 밀어 전원을 
켜 주십시오. UMPC가 부팅되고, 운영체
제가 자동으로 시작됩니다.

3. 	이제 데스크탑 PC를 사용하는 것과 같이 
UMPC를 사용할 수 있습니다.

참고: UMPC가 전원이 켜지지 않으면 Hold 버튼이 잠김 상태(빨간색)이거나 배터리
가 충전되었는지 확인해 주십시오.
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전원 설정 관리
UMPC는 전원 설정 관리를 통해 배터리 전원 절약, 시스템 성능 최대화 또는 이 둘 모
두를 동시에 만족하도록 제어가 가능합니다.

전원 사용 계획 선택

UMPC는 다양한 전원 관리 설정을 통해 사용자에게 적합한 전원 사용 계획을 제공합니
다. 이 전원 사용 계획은 ASUS POWER4 Gear eXtreme을 사용하여 성능의 최대화는 
물론 배터리 사용 시간을 늘리기 위해 디스플레이 밝기 및 CPU 클럭과 같은 시스템 설
정을 조절 가능하도록 해 줍니다.

전원 사용 계획 선택:

1.	 UMPC 화면에서  > Control Panel > Classic View > Power Options을 클릭해 
주십시오.

2.	 아래와 같은 세가지 전원 사용 계획 중에 하나를 선택해 주십시오:

전원 사용 계획 설명

Power4 Gear Entertainment 고성능을 제공하며, 온라인 게임 또는 DVD 재
생시에 배터리 전력을 절약합니다.

Power4 Gear Battery Saving 가장 긴 배터리 수명을 제공하며, UMPC의 성
능을 최대한 줄입니다.

Power4 Gear High 
Performance

UMPC의 성능을 최대로 제공하지만, 가장 짧은 
배터리 사용 시간을 제공합니다.

3.	 전원 사용 계획 설정을 조절하려면 Change plan settings(전원 사용 계획 설정 변
경)을 클릭해 주십시오. 사용자는 UMPC가 배터리 모드 또는 AC 전원 입력 모드에
서의 전원 사용 계획의 비활성화 및 디스플렝 설정 또한 조절이 가능합니다.

	 세부 설정 변경을 하려면 Change advanced power settings(전원 설정 세부 변
경)을 클릭해 주십시오.
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전원 사용 계획 생성
전원 사용 계획 생성:

1.	 UMPC 화면에서  > Control Panel > Classic View > Power Options을 클릭해 
주십시오.

2.	 Create a power plan(전원 사용 계획 생성)을 클릭해 주십시오.

3.	 아래 전원 사용 계획 옵션을 선택해 주십시오:

전원 사용 계획 설명

Balanced UMPC의 성능과 전력량 간의 사용 균형을 맞춥니다.

Power saver 가장 긴 배터리 사용 시간을 제공하며, UMPC의 성능
을 최대한으로 제한합니다.

High performance UMPC의 성능을 최대로 하지만, 배터리 사용량이 많
아집니다.

4.	 Plan name 항목에서 사용자가 설정한 사용 계획의 이름을 지정하고, 다음을 클릭
해 주십시오.

5. 	필요한 설정을 지정하고, Create을 클릭해 주십시오.

UMPC를 절전 모드로 전환

절전 모드에서 모든 열려 있는 데이터와 프로그램이 RAM에 저장되고, UMPC는 절전 
상태로 전환됩니다.

UMPC를 절전 모드로 전환하려면 아래의 지시사항을 따라 주십시오:

1.	   > 를 클릭하고,

2.	  >  > Sleep를 클릭해 주
십시오.

3.	 UMPC의 전면부에 위치한 절전 
모드 버튼 을 눌러 주십시오.

UMPC를 절전 모드로부터 복구 하
려면 LCD 화면을 가볍게 두드리거
나 UMPC 좌측면에 위치한 전원 버
튼을 눌러 주십시오.



2			   UMPC 
사용하기

• UMPC 탐색

• 데이터 입력

• UMPC 보안 설정

• Windows® 도움말 및 지원

이 장에서
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UMPC 탐색
버튼 (방향/종료 버튼, 조이스틱, 좌/우 키), 스타일러스, 제스처를 이용해 UMPC의 프
로그램에서 항목 선택 또는 탐색이 가능합니다.

탐색 버튼 사용

조이스틱

조이스틱을 이용해 화면에서 커서를 이동할 
수 있습니다. 버튼(방향/엔터 버튼 및 좌/우 
버튼)과 함께 조이스틱을 사용하면 마우스와 
같은 기능을 편리하게 이용할 수 있습니다.

좌/우 버튼

좌/우 버튼은 마우스의 좌우 
버튼의 클릭과 같은 기능을 
합니다.

5-Way 탐색 버튼

다음 페이지에서 이 버튼의 기능을 확인할 
수 있습니다.
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스타일러스 사용
DigiPen 스타일러스를 이용해 항목을 선택하거나, UMPC의 프로그램의 탐색은 물론 
UMPC의 입력 패널을 이용해 문자 쓰기가 가능합니다. 

DigiPen 스타일러스를 통해 마우스와 같은 탐색 기능을 편리하게 이용 가능합니다.

스타일러스 기능

스타일러스 마우스 기능

탭 클릭 항목을 선택합니다.

더블 탭 더블 클릭 항목을 실행합니다.

누른 채로 유지 오른쪽 클릭 마우스 아이콘을 표시하며, 마우스 아이콘 
우측을 가볍게 두드려 주십시오.

누른 채로 드래그 드래그 항목에 클릭한 채로 드래그하여 이동이 가
능합니다.

버튼 기능

 왼쪽 방향 페이지의 왼쪽으로 스크롤합니다.

메뉴 목록에서 왼쪽으로 다음 메뉴를 보여주거나, 하위 메뉴를 닫
습니다.

 오른쪽 방향 페이지의 오른쪽으로 스크롤합니다.

메뉴 목록에서 오른쪽으로 다음 메뉴를 보여주거나 하위 메뉴를 엽
니다.

 위 방향 페이지를 위로 스크롤합니다.

선택 옵션에서 선택 항목을 위로 이동시킵니다.

 아래 방향 페이지를 아래로 스크롤합니다.

선택 옵션에서 선택 항목을 아래로 이동시킵니다.

 엔터 버튼
명령을 확인합니다.

5-Way 탐색 버튼

참고:	 스타일러스를 가볍게 두드리는 것만으로도 복사, 붙여넣기, 취소, 삭제와 같
은 탐색 및 편집 기능을 수행할 수 있습니다. 펜의 사용법을 연습하려면   > Tablet 
PC Pen Training을 실행해 주십시오.
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태블릿 PC의 입력 패널을 실행하려면 다음 중 하나의 지시사항을 따라 주십시오:

•	 웹브라우저 또는 워드 프로세서와 같은 사용 하려는 애플리케이션을 우선 실행해 주십시오. 
DigiPen 스타일러스를 실행하여 태블릿 PC 아이콘 을 가볍게 두드려 주십시오. 

•	 화면의 왼쪽에 살짝 나온 입력 패널 탭을 가볍게 두드려 주십시오.

데이터 입력
사용자는 UMPC에서 문자 또는 기호를 입력하기 위해 접이식 키보드 또는 태블릿 
PC의 입력 패널을 사용할 수 있습니다.

참고:	 접이식 키보드는 UMPC에 포함되어 있지 않은 액세서리 옵션입니다.

태블릿 PC 입력 패널 사용
Microsoft® Vista 태블릿 PC 입력 패널을 이용해 표준형 키보드 없이도 UMPC에서 문
자 입력이 가능합니다. 태블릿 PC 입력 패널은 세가지 입력 방식을 사용자에게 제공합
니다: Writing Pad(쓰기 패드), Character Pad(문자 패드), On-screen Keyboard(화면 
상의 키보드)

태블릿 PC 입력 패널 아이콘

태블릿 PC 입력 패널 탭 태블릿 PC 입력 패널
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쓰기 패드 사용

쓰기 패드를 이용해 연속적으로 쓰기가 가능하며, 손으로 쓰여진 문자가 타이핑된 문
자로 전환되어 입력됩니다.

쓰기 패드 사용:

1. 워드패드와 같은 워드프로세서를 실행해 주십시오.   > All Programs > 
Accessories > WordPad를 클릭하여 워드패드를 실행 가능합니다.

2.	 을 가볍게 두드리면 태블릿 PC 입력 패널이 실행됩니다.

3.	 입력 패널에서 을 두드리면 쓰기 패드가 실행됩니다.

4.	 DigiPen 스타일러스를 이용해 입력하려는 문자를 화면 상에 써 주십시오.

5.	 쓰기를 완료한 후에 Insert을 두드리면 워드패드에 문자가 입력됩니다.

중요!	 읽기 쉽게 문자를 써 주십시오.

참고:	 공백 및 탭과 같은 기본 편집 기능을 사용하거나 문자를 삭제하려면 제스처
를 이용해 주십시오. 추가 정보는 사용자 설명서의 제스처 사용 부분을 참고해 주십시
오.



4242

문자 패드 사용

문자 패드는 손으로 쓰여진 문자, 부호 등을 하나씩 전환합니다.

문자 패드 사용:

1. 워드패드와 같은 워드프로세서를 실행해 주십시오.   > All Programs > 
Accessories > WordPad를 클릭하여 워드패드를 실행 가능합니다.

2.	 을 두드리면 태블릿 PC 입력 패널이 실행됩니다.

3.	 입력 패널에서 를 두드리면 문자 패드가 실행됩니다.

4.	 DigiPen 스타일러스를 이용해 입력하려는 문자를 화면 상에 써 주십시오. 문자 패
드는 쓰여진 문자를 변환하여 입력합니다.

5.	 완료 후에 Insert을 두드리면 워드패드에 문자가 입력됩니다.

중요: 읽기 쉽게 문자를 써 주십시오.

참고: 제스처를 이용하여 공백 또는 탭의 입력과 같은 기본적인 편집 작업들을 수행하
거나 문자를 삭제할 수 있습니다. 추가 정보는 사용자 설명서의 제스처 사용 부분을 참
고해 주십시오.

화면 상의 키보드 사용하기

화면 상의 가상 키보드에서는 스타일러스, 마우스 또는 조이스틱을 이용한 데이터 입
력이 가능합니다.
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화면 상의 키보드 사용:

1. 워드패드와 같은 워드프로세서를 실행해 주십시오.   > All Programs > 
Accessories > WordPad를 클릭하여 워드패드를 실행 가능합니다.

2.	 을 두드리면 태블릿 PC 입력 패널이 실행됩니다.

4.	 입력 패널에서 을 두드리면 화면 상의 키보드가 실해됩니다.

5.	 입력하려는 키를 두드려 주십시오.

제스처 사용
제스처는 스타일러스를 이용해 그릴 경우 UMPC가 인식하게 되는 기호입니다. 태블릿 
PC 입력 패널에서 제스처를 사용해 공백 또는 탭 입력과 같은 기본 적인 편집 작업이나 
문자를 삭제할 수 있습니다. 태블릿 PC의 입력 패널에서 두 가지 방식의 손직을 사용해 
주십시오:

•	 글씨를 지우는 제스처 사용자가 쓰기 패드 또는 문자 패드를 사용 중인 경우 편리하
게 문자를 삭제할 수 있습니다. 

•	 편집용 제스처 공백과 탭과 같은 기본 편집 작업 등을 수행할 수 있습니다.

Scratch-out 제스처 사용

Scratch-out 제스처를 사용해 쓰기 패드 또는 문자 패드에서 문자를 삭제할 수 있습니
다. Microsoft® Vista Tablet PC Edition의 경우에는 다음과 같은 글씨를 지우는 제스처
를 지원합니다:

•	 수직 Scratch-out (M 또는 W과 같은 성향)

•	 각도가 있는 Scratch-out

•	 Z 모양의 Scratch-out

•	 원형의 Scratch-out
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•	 수직 Scratch-out

편집용 제스처

쓰기 패드 또는 문자 패드에서 편집용 제스처를 사용 가능합니다. 아래와 같은 두 세트
의 편집용 제스처를 사용할 수 있습니다:

•	 핸드헬드 PC 또는 PDA 장치에서 사용되는 일반적인 편집용 제스처

•	 중국 정부가 채택한 간체 중국어(PRC) 표준, GB/T 18790-2002에서 사용되는 편
집용 제스처

핸드헬드 PC 또는 PDA 장치에서 사용되는 일반적인 편집용 제스처

기호 설명

엔터

아래를 향한 직선에서 90도의 각을 이루면서 왼쪽으로 방향을 꺽는 선
을 그려 주십시오.

백스페이스

긴 선을 그려 주십시오.

스페이스

긴 선을 그려 주십시오.

탭

•  위를 향한 직선에서 90도의 각을 이루면서 오른쪽으로 방향을 꺽는 
선을 그려 주십시오.

•  오른쪽으로 꺽여진 선은 위를 향한 선보다 2~4배 정도 더 길어야 합
니다.

중국 정부가 채택한 간체 중국어(PRC) 표준, GB/T 18790-2002에서 사용되는 편집용 제스처

기호 설명

엔터

백스페이스

스페이스

탭
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편집용 제스처 선택
편집용 제스처 선택:

1.	 태블릿 PC 입력 패널을 실행해 주십시오.

2. 	Tools > Options > Gestures 탭을 두드려 주십시오.

3.	 제스처 탭에서 Use gestures commonly used on handheld computers (핸드헬드 
PC 또는 PDA 장치에서 사용되는 일반적인 편집용 제스처)또는 Use gestures from 
the Simplified Chinese (PRC) standard, GB/T 18790-2002(중국 정부가 채택한 
간체 중국어(PRC) 표준, GB/T 18790-2002에서 사용되는 편집용 제스처)를 선택
해 주십시오.

참고: 태블릿 PC 입력 패널의 기타 기능 및 제스처에 관련된 추가 정보는 태블릿 
PC 입력 패널의 Help (도움말) 메뉴 혹은 Microsoft® Windows Help and Support 
(Widnows 도움말 및 지원)에서 확인이 가능합니다.
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화면 칼리브레이션
UMPC는 화면 칼리브레이트를 통해 DigiPen 스탕이러스 또는 손가락을 이용한 태핑시 
터치스크린 기능이 보다 원활하고 정확하게 동작합니다.

화면 칼리브레이션:

1.	  > Control Panel를 클릭해 주십시오.

2.	 Classic View에서 Tablet PC Settings를 두드려 주십시오.

3.	 General 탭에서 Calibrate를 클릭해 주십시오.

4. 	각 코너에 나타나는 십자선의 중앙을 조심스럽게 두드려서 칼리브레이션 과정을 완
료해 주십시오.

5.	 완료 후, OK를 두드리면 칼리브레이션 데이터가 저장됩니다.

UMPC 보안 설정
ASUS Security Protect Manager 사용
Security Protect Manager를 사용하면 Windows 및 기타 애플리케이션에서 사용자의 
지문 데이터 또는 비밀번호와 같은 등록된 정보를 통해 로그인이 가능합니다.

지문 데이터 등록

UMPC의 지문 센서는 인증되지 않은 접근으로부터 사용자의 장치를 보호합니다. 사용
자는 지문 센서를 이용해 사용자의 지문 증명을 UMPC의 인증 메카니즘으로 구성할 수 
있습니다.

지문 데이터 등록:

1.	  > Control Panel > ASUS Security Protect Manager을 클릭해 주십시오.

2.	 Settings and Options 목록에서 Multifactor Authentication을 선택해 주십시오.

3.	 Credentials 탭을 선택한 후에 Fingerprint Authentication를 선택해 주십시오.

4.	 Register을 두드리면 ASUS Security Protect Manager Registration Wizard을 실행
합니다.

5.	 이어지는 화면의 지시사항에 따라 지문 데이터를 등록해 주십시오. 사용자는 최소 
두 개 이상의 지문 데이터를 입력해야 합니다.
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비밀번호 설정

비밀번호 설정:

1.	  > Control Panel > ASUS Security Protect Manager를 클릭해 주십시오.

2.	 Settings and Options 목록에서 Multifactor Authentication를 선택해 주십시오.

3.	 Credentials 탭을 선택한 후에 Password Authentication를 선택해 주십시오.

4.	 Register를 두드리면 ASUS Security Protect Manager Registration Wizard를 실행
합니다.

5.	 이어지는 화면의 지시사항에 따라 비밀번호 설정을 완료해 주십시오. 

로그온 카테고리 지정

사용자는 Windows 및 기타 애플리케이션을 로그온하기 위해 등록된 지문 데이터 또는 
비밀번호 혹은 둘 모두를 입력하도록 설정할 수 있습니다.

로그온 카테고리 지정: 

1.	   > Control Panel > ASUS Security Protect Manager을 클릭해 주십시오.

2.	 Settings and Options 목록에서 Multifactor Authentication를 선택해 주십시오.

3.	 Policies 탭에서 로그온 카테고리를 선택해 주십시오.

4.	 Apply를 클릭하여 설정을 저장해 주십시오.

ASUS Protect Manager구성

ASUS Protect Manager 구성:

1.	  > Control Panel > ASUS Security Protect Manager를 클릭해 주십시오.

2.	 Settings and Options 목록에서 General Options을 선택해 주십시오.

3.	 필요한 옵션을 선택해 주십시오.

4.	 Apply를 클릭하여 설정을 저장해 주십시오.
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Windows® 도움말 및 지원
Windows® Help and Support (도움말 및 지원)은 Windows® Vista 플랫폼에서 애플리
케이션을 사용하는데 데한 도움말 및 안내를 제공합니다. 

 > Help and Support을 선택하여 Windows® 도움말 및 지원을 실행해 주십시오. 



3	 멀티미디어 
기능

• Windows® Media Center 사용

• 카메라 사용

이 장에서
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Windows® Media Center 사용
Windows® Media Center는 사용자의 UMPC를 홈 엔터테인먼트 시스템으로 사용할 수 
있도록 해 주는 미디어 애플리케이션입니다. 생방송 TV의 시청 및 녹화, 사진 및 비디
오 클립 감상, CD 및 DVD 제작, 인터넷으로부터 영화 또는 음악 파일과 같은 스트리밍 
파일 시청/감상 등이 가능합니다.

Windows Media Center 사용:

1.	 UMPC를 외장 모니터와 연결해 주십시오.

참고: 이 사용자 설명서 1장의 외장 모니터 연결 부분을 참고해 주십시오.

2.	  > All Programs > Windows Media Center을 클릭하거나 Windows Media 	
	 Center 버튼을 눌러 주십시오. 

Windows® Media 
Center 버튼

참고: Windows Media Center의 기타 기능에 대한 추가 정보는 Windows Help and 
Support에서 확인이 가능합니다.

�
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카메라 버튼

카메라 사용
2.0메가픽셀 카메라를 이용해 사진 촬영 및 비디오 클릭 제작은 물론 오디오/음성 녹음 
또한 가능합니다.

카메라 켜기
사진 및 비디오를 촬영하려면 아래 지시사항 중 하나를 따라 주십시오:

	 •	 UMPC의 상판부에 위치한 카메라 버튼을 눌러 주십시오.

	 •	  > All Programs > ASUS Utility > LifeFrame를 클릭해 주십시오.

카메라 기능을 종료하려면 카메라 화면에서 종료 아이콘 을 두드려 주십시오.

카메라 기능

사용자의 사진을 꾸미려면 다음의 아이콘 중 하
나를 두드려 주십시오. 이 아이콘에 대한 추가 정
보는 다음 페이지를 참고해 주십시오.

위의 아이콘 중 하나를 클릭하여 캡쳐 
모드를 설정해 주십시오. 캡쳐 모드에 
대한 정보는 다음 페이지의 표를 참고
해 주십시오.

해당 슬라이드를 두드리면 사진, 비디오 클립 또는 음성 
녹음의 썸네일을 확인할 수 있습니다.
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아이콘 캡쳐 모드 설명

모니터 화상 회의를 위해 사용 가능합니다.

미리 보기 사진, 비디오 클립, 오디오/비디오 레코딩, 녹화된 화상 회
의를 미리 보기 위해 사용 가능합니다.

카메라 사진 촬영을 위해 사용 가능합니다.

비디오 녹화 오디오/비디오 레코딩을 위해 사용 가능합니다.

음소거된 캠코더 셔터 소리와 같은 카메라 소리 없이 비디오를 촬영하려면 
이 모드를 사용해 주십시오.

캠코더 비디오를 촬영하려면 이 모드를 사용해 주십시오.

사진 촬영

사진 촬영:

1.	 카메라 애플리케이션을 실행해 주십시오.

2.	 을 두드려서 캡쳐 모드를 카메라 모드로 설정해 주십시오.

3.	 UMPC롤 대상을 설정한 후에 카메라 버튼을 클릭해 주십시오.

4.	 단계 3을 반복하여 추가로 사진을 촬여할 수 있습니다.

참고: 기본 적으로 사진은 LifeFrame 폴더 C://Users/Your User Name/Documents/
ASUS/LifeFrame/Image에 저장됩니다.

사용 가능한 캡쳐 모드

UMPC의 카메라 기능을 아래의 캡쳐 모드 중 하나로 설정해 주십시오:
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아이콘 설명

Shooting mode (촬영 모드)

촬영 모드 중의 하나를 선택해 주십시오: Night Scene(야간 촬영), Portrait(인
물 사진), Slow Shutter(느린 셔터 속도), Custom(사용자 정의). 

Flash (플래시)

플래시 모드를 켜거나 끌 수 있습니다.

Timer (타이머)

타이머를 5~10초 중에 하나로 선택하거나, 타이머를 끌 수 있습니다.

Continuous Shoot (연속 촬영)

연속되는 사진을 촬영할 경우 균일한 효과를 얻을 수 있습니다.

Resolution (해상도)

화면 해상도를 160 x 120, 176 x 240, 320  x 240, 352 x 288, 640 x 480 중의 
하나로 선택해 주십시오.

Date (날짜)

사진에 추가되는 날짜 스탬프의 형식을 설정할 수 있습니다.

JPG Quality (JPG 품질)

사진이 .jpg 파일일 경우 이 아이콘을 두드려서 jpg의 품질을 Good, Fine, 
Normal 중의 하나로 선택할 수 있습니다.

Image File Type (이미지 파일 포맷)

사진 파일 포맷을 BMP, JPG, GIF, PNG, TIFF 중의 하나로 설정할 수 있습니다.

Brightness (밝기)

밝기 수준을 설정할 수 있습니다.

Contrast (대비)

색상 대비 수준을 설정할 수 있습니다.

Default (기본값으로 복구)

카메라의 설정 값을 기본값으로 복구할 수 있습니다.

Filter (필터)

사진에 필터 효과를 추가할 수 있습니다.

Frame (프레임)

사진에 프레임 효과를 추가할 수 있습니다.

Advanced Settings (고급 설정)

고급 설정을 구성할 수 있습니다.

카메라 설정 구성
다음의 카메라 설정 아이콘을 이용하여 카메라 설정을 구성해 주십시오:
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미리 보기 모드 사용
저장된 사진, 비디오 클립 재생, 오디오/음성 레코딩, 화상 회의 등을 미리 확인할 수 
있습니다.

미리 보기 모드 사용:

1.	 카메라 애플리케이션을 실행해 주십시오.

2.	 을 두드려서 미리 보기 모드로 설정해 주십시오.

3.	 사진, 비디오 클립 재생, 오디오/음성 레코딩, 화상회의 미리 보기 중 하나를 선택해 
주십시오.

	 •	 카메라 탭 을 두드려서 저장된 사진을 확인할 수 있습니다. 카메라 탭은 	
	 기본 탭입니다.

	 •	 비디오 탭 을 두드려서 저장된 비디오 클립을 확인할 수 있습니다.

	 •	 오디오 탭 을 두드려서 저장된 오디오/음성 레코딩을 확인할 수 있습니다.

	 •	 모니터 탭 을 두드려서 저장된 화상 회의를 확인할 수 있습니다.

4.	 재생 버튼 을 두드려서 다음 또는 이전의 항목을 탐색할 수 있습
니다. 

	 또한 미리 보기 모드에서 효과를 추가하거나, 사진에서 변경된 편집 사항을 되돌릴 
수 있으며, 삭제/E-메일에 사진을 추가할 수도 있습니다.

효과 방법

사진에 필터 효과 적용 필터 효과를 적용하려는 사진을 두드리고, 를 두드린 후에 
필터 효과를 선택해 주십시오.

사진에 프레임 적용 프레임 효과를 적용하려는 사진을 두드리고, 을 두드린 후
에 프레임을 선택해 주십시오.

펜/편집 선의 색 변경 을 두드리고, 색을 선택해 주십시오. 편집하려는 사진 위에 
문자 또는 기호를 그려 주십시오.

사진에 스탬프 추가 스탬프를 추가하려는 사진을 두드리고, 을 두드린 후에 스
탬프를 선택해 주십시오.

변경 사항 취소 편집한 사진에 오른쪽 버튼을 클릭하고, Undo를 선택해 주십
시오.

사진 인쇄 인쇄하려는 사진에 오른쪽 버튼을 클릭하고, Print를 두드려 주
십시오.

사진을 바탕 화면 배경 
무늬로 지정

바탕 화면 배경 무늬로 지정하려는 사진에 오른쪽 버튼을 클릭
하고, Set as Desktop Background를 두드려 주십시오.

사진을 다른 폴더에 
복사

다른 폴더에 복사하려는 대상 사진에 오른쪽 버튼을 클릭하고, 
Copy To를 두드려 주십시오.
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Bluetooth® 사용
본 UMPC는 단거리 무선 통신 기술인 Bluetooth®를 탑재하여 PC, 휴대용 장치, 헤드
셋, GPS 리시버와 같은 기타 Bluetooth 지원 장치들과 약 10미터 내의 범위 안에서 통
신이 가능합니다. Bluetooth® 장치는 정보를 교환하기 위한 지정 범위 안에만 있으면 
되며, 기타 물리적 연결을 필요로 하지 않습니다.

참고: UMPC에서는 기본적으로 Bluetooth 기능을 비활성화합니다.

Bluetooth 연결 설정
사용자의 UMPC는 내장 Bluetooth® 송수신기를 탑재하고 있습니다. 사용자는 
UMPC를 기타 장치와 통신하도록 하려면 먼저 UMPC와 기타 Bluetooth 지원 장치 간
의 Bluetooth 연결을 생성해야 합니다.

기타 장치와 Bluetooth 연결 생성:

1.	 UMPC와 기타 장치가 가까운 거리에 있고, 서로를 발견할 수 있는지 확인해 주십시
오. 

		

중요: 기타 장치가 사용자의 UMPC를 발견할 수 있도록 하려면 장치의 사용자 설명서
를 참고해 주십시오.

2.	 Devices 탭에서 Add을 클릭하고, My device is set up and ready to be found을 
선택해 주십시오.

3.	 Next를 클릭하면 기타 Bluetooth 장치 검색을 시작합니다.

4.	 사용 가능한 Bluetooth 장치 목록에서 연결하려는 장치를 선택하고, Next를 클릭해 
주십시오.

5.	 UMPC에서 8~16 자로 구성된 PIN 키를 입력하고, Next를 클릭해 주십시오.

참고: 일부 Bluetooth 장치는 내장된 PIN 키를 포함하고 있습니다. 이 PIN 키는 장치
의 사용자 설명서를 참고해 주십시오.

6.	 기타 장치에서 같은 PIN 키를 입력해 주십시오.

7.	 완료 후, Finish를 클릭해 주십시오.

NOTE:	 UMPC와 기타 장치 간에 Bluetooth 연결이 한 번 생성되면, 장치는 장치들 
사이에서 전파 정보에 반드시 발견되어야 할 필요는 없습니다. Bluetooth®가 켜져 있
기만 하면 됩니다.
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기타 Bluetooth 지원 장치 추가
사용자는 UMPC에서 Bluetooth 프린터, 마우스 및 키보드와 같은 주변장치를 사용할 
수 있습니다.  

기타 Bluetooth 지원 장치 추가:

1.	 Devices 탭에서 Add를 클릭하면, Add Bluetooth Device Wizard 창이 나타납니다. 
My device is set up and ready to be found를 선택해 주십시오.

2.	 Next를 클릭하여 기타 Bluetooth 장치의 검색을 시작해 주십시오.

3.	 사용 가능한 Bluetooth 장치 목록에서 UMPC에서 사용을 원하는 장치를 선택하고, 
Next를 클릭해 주십시오.

4.	 Don’t use a passkey를 선택하고, Next를 클릭하면, 장치를 추가할 수 있습니다. 

5.	 완료 후에, Finish를 클릭해 주십시오.

중요: UMPC의 모델에 따라 Bluetooth 송수신기의 탑재 여부가 달라집니다.
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3G SIM 카드 (옵션) 사용
사용자의 UMPC에 3G SIM 카드를 설치하면 무선으로 인터넷에 연결하여 E-메일 확
인, 인터넷 탐색, 온라인 채팅 및 Bluetooth 헤드셋을 이용한 통화 기능을 이용 가능합
니다.

중요: UMPC의 모델에 따라 3G SIM 카드 슬롯의 적용 여부가 달라집니다. 3G SIM 
카드 슬롯의 탑재 여부는 사용자의 UMPC 모델을 확인해 주십시오.

3G SIM 카드 설치

3G SIM  카드 설치:

1.	 배터리 래치를 아래로 누르고, 배터리 
팩을 꺼내 주십시오.

2.	 3G SIM 카드의 금속 접촉 부분이 아래
를 바라보도록 하여, 그림과 같이 카드
의 깍인 부분이 슬롯의 왼쪽 윗부분에 
오도록 밀어 넣어 주십시오.
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3.	 배터리 팩을 다시 설치해 주십시오.

3G SIM 카드 활성화
3G SIM 카드를 UMPC에 설치한 후에 3G Watcher 애플리케이션을 통해 3G SIM 카드
를 활성화해야 합니다.

3G SIM 카드 활성화하기:

1.	 3G Watcher 애플리케이션을 실행해 주십시오. 아래의 지시사항 중 하나에 따라 주
십시오:

	 •	  > 3G Watcher를 클릭해 주십시오.

	 •	 작업 표시줄에서 3G Watcher 아이콘 을 더블 클릭해 주십시오.

사용자의 3G SIM 카드가 기본 패스키(Pass Key)를 가지고 있을 경우 SIM 카드의 패
스키를 묻는 팝업 창이 나타납니다.

2.	 3G Watcher 메인 화면에서 
Tools > Options를 클릭해 주
십시오.
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2.	 Settings을 클릭해 주십시오. 
드롭다운 목록에서 사용자의 
이동 통신 서비스 제공자를 선
택하고, Yes를 클릭해 주십시
오. 3G Watcher는 메인 화면
으로 돌아갑니다.

3.	 Connect를 클릭하여 무선 연
결을 시작해 주십시오.

4.	 3G Watcher는 연결 상태를 표
시합니다. 사용자는 인터넷 서
핑 또는 E-메일의 확인이 가능
합니다.



6161

무선 연결 켜기/끄기

무선 연결 켜기:

•	 3G Watcher 메인 화면에서 Tools > 
Turn Radio Off를 클릭해 주십시오.

무선 연결 켜기:

•	 3G Watcher 메인 화면에서 Tools 
>Turn Radio On을 클릭해 주십시오.
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GPS

GPS 사용
사용자의 UMPC는 GPS 송수신기를 내장하여 GPS 기능을 내장한 GPS 장치와 같이 
동작합니다.

주의: 이 부분을 다른 물
체로 가리지 마십시오. 
GPS 신호를 방해할 수 
있습니다.

외장 GPS 안테나 설치 (옵션)

외장 GPS 안테나를 설치하면 GPS 보다 향상된 신호 수신율을 제공합니다. 

참고: 사용 중이 아닌 외장 GPS 안테나은 서늘한 곳에 보관해 주십시오.

GPS 기능 설정:

GPS 기능 설정:

1.  > ASUSMAP GPS를 선택해 주십시오.

2. GPS 인터페이스 항목에서 COM2를 선택하고, Baudrate 항목에서 4800를 선택한 
후에 OK 를 클릭해 주십시오.

3. xxx를 클릭해 주십시오. Position 모드가 실행됩니다. Position 상태가 화면의 우측 
상단 코너에 나타납니다: ? In progress, X Fail, Tick Finished.

4. GPS signal, search for maps 및 other GPS-related  기능을 체크해 주십시오.
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무선 네트워크에 연결
무선 기능을 통해 UMPC를 무선 네트워크에 연결할 수 있습니다.

무선 네트워크에 연결:

참고:	 무선 어댑터가 설치되어 있고, UMPC와 연결되어 있는지 확인해 주십시오.

1.	 작업 표시줄의 무선 콘솔 아이콘 
을 더블 클릭하고, 아래의 아이콘 중에 
하나를 선택해 주십시오:

2. 	WLAN 아이콘에 마우스 오른쪽 버튼을 
클릭하고, Connect to a network를 선
택해 주십시오.

아이콘 기능

무선 및 Bluetooth 기능을 모두 
켭니다.

무선 기능만을 켭니다.

Bluetooth 기능만을 켭니다.

4.	 사용 지역에 기타 다수의 네트워크가 
함께 사용 중일 경우 Show Wireless를 
클릭해 주십시오.



6464

4.	 연결하려는 무선 네트워크를 선택해 
주십시오.

5.	 연결을 위해 미리 설정한 비밀번호를 
입력해 주십시오.

5.	 연결이 성공적으로 이뤄지면 연결 상
태가 표시됩니다.
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문제 해결

• 문제 해결
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문제 해결

AQ UMPC가 멈춘 경우 어떻게 전원을 종료해야 합니까?

A 전원 버튼을 4~6초간 눌러 주십시오.

AQ UMPC의 전원을 켤 수 없을 경우 어떻게 해야 합니까?

A
1. 배터리가 올바르게 설치되어 있는지, AC 어댑터가 올바르게 연결되어 있
는지 확인해 주십시오.

2. HOLD 키를 확인해 주십시오. 키가 잠겨 있는지 확인해 주십시오.

AQ UMPC 안으로 물이 들어간 경우 어떻게 해야 합니까?

A 1. UMPC의 전원을 켜지 마십시오.

2. 어댑터를 즉시 연결 해제하고, ODD, 플로피 또는 저장 장치와 같은 외장 
장치를 제거해 주십시오.

3. 깨끗하고 물기 없는 천을 이용하여 UMPC를 건조해 주십시오.

4. 인증된 서비스 기술자에 즉시 문의해 주십시오.

AQ 시스템을 복구할 수 없습니다.

A
가능성이 있는 원인:

1. 외장 저장 장치/메모리의 데이터가 올바르지 않은 장소에 저장된 경우

2. UMPC와 호환되지 않는 USB, CF, MMC, 스마트 미디어 등의 외장 장치가 
연결된 경우

3. Windows XP에 Windows 98 애플리케이션을 설치한 것과 같이 UMPC와 
호환되지 않는 애플리케이션/드라이버를 설치한 경우

4. 운영체제 (OS) 문제 관리: OS에 의해 관리되는 ACPI (Advanced 
Configuration and Power Interface) 



6767

AQ 시스템 복구를 위한 방법:

A
1. 주변 장치 및 해당 드라이버의 삭제.

2. BIOS 업데이트

3. 드라이버 업데이트

4. 불필요한 애플리케이션의 삭제

5. OS 재설치

6. 인증된 서비스 기술자에게 문의.

AQ 배터리 사용 시간을 늘리기 위한 방법

A 1. LCD 밝기를 어둡게 조절

2. 볼륨을 낮게 조절

3. 전원 절약 모드 활성화
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참고 정보
미연방 통신 위원회 성명서 
본 장치는 FCC 규정 제 15조를 준수하며, 작동 조건은 다음과 같습니다:

•	 본 장치는 해로운 장해를 일으키지 않습니다.

•	 본 장치는 불필요한 작동을 유발하는 장해를 포함하여 모든 장해를 수용해야 합니
다.

본 기기는 FCC 규정 제 15조에 의거하여 테스트되었으며, B 등급 디지털 장치에 대한 
제한 사항을 준수합니다. 이러한 제한 사항은 주거 지역에서 장치 설치시에 유해한 간
섭을 방지하기 위한 것입니다. 본 장치는 RF(Radio Frequency) 에너지를 생성, 사용
하고 방출하므로, 지시 사항에 따라 장치를 설치하지 않을 경우 전파 간섭이 발생할 수 
있습니다. 장치의 전원을 껐다 켜 봄으로써, 라디오 또는 텔레비전 수신에 대한 유해한 
간섭이 발생하는지의 여부를 확인할 수 있습니다. 간섭이 발생하는 경우 다음과 같은 
방법으로 전자파 장해를 교정하는 것이 좋습니다:

•	 수신 안테나의 방향을 바꾸거나 위치를 바꾸어 주십시오.

•	 기기와 수신기 사이의 거리를 조정해 봅니다.

•	 기기를 수신기에 연결된 콘센트가 아닌 다른 콘센트에 연결하십시오. 

•	 판매 대리점이나 경험이 풍부한 기술자에게 도움을 요청하십시오.

경고!  FCC 방출 제한 규정을 준수하고, 라디오/TV 수신 장해를 방지하기 위해 FCC 
방출 제한 규정을 준수한 차폐형 전원 코드를 사용해 주십시오. 반드시 본사에서 공급
하는 전원 코드를 사용해 주십시오. I/O 장치를 본 장비에 연결할 때는 반드시 차폐형 
전선을 사용해 주십시오. 본사 책임자의 승인을 받지 않고, 장치를 변경하거나 개조할 
경우 사용자의 기기 작동 권한이 무효화될 수 있습니다.

(워싱턴 DC 소재 미연방 공부청, 국정기록 보관소, 미연방 정부 인쇄국의 연방 규정집 
#47 제 15조 193, 1993년판에서 발췌했습니다.)

전자파 적합 등록 안내 (Class B)

이 기기는 가정용으로 전자파 적합 등록을 한 기기로서 주거지역은 물
론 모든 지역에서 사용할 수 있습니다.
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WLAN & GSM/CDMA
본 UMPC는 WLAN 및 GSM/CDMA 기능만을 지원합니다. 본 UMPC는 음성 전송 기능을 
지원하지 않습니다.

오스트리아 SAR 요구사항
무선 LAN 또는 GSM/WCDMA 어댑터를 이용할 경우 GSM/WCDMA 전송 중 어댑터와 
내장안테나는 인체로부터 최소 20CM 이상 떨어져서 배치해야 합니다.

적합성 성명 (R&TTE directive 1999/5/EC)
아래의 항목들은 적합성이 충분히 고려된 후에 발표되었습니다:

•	 [Article 3]에 의한 필수 요구사항

•	 [Article 3.1a]에 의한 건강과 안전에 관한 보호 요구사항

•	 [EN 60950]에 따르는 전기적 안정성 검사

•	 [Article 3.1b]에 의한 전자기적 호환성에 관한 검사

•	 [EN 301 489-1] & [EN 301]에 의한 전자기적 호환성에 관한 검사

•	 [489-17]에 따르는 검사

•	 [Article 3.2]에 의한 무선 스펙트럼의 효과적인 사용

•	 [EN 300 328-2]에 따르는 무선 테스트 기계에 대한 검사

CE Mark 경고
본 제품은 국내 환경에서 B 등급 제품입니다. 본 제품은 전파 장애를 야기할 수 있으
며, 이러한 경우 적절한 조치를 취해 주시기 바랍니다.

캐나다 IC 전자파 노출 성명
이 장치는 예기치 못한 환경에서의 IC 전자파 노출 제한의 적합성을 만족합니다. IC RF 
노출 적합성 부합에 대한 요구를 지속하기 위해 전송 중에 전송 안테나의 직접적인 접
촉을 피해 주십시오. 사용자는 RF 노출 적합성을 만족하기 위한 특정 동작 지시사항을 
따라야 합니다.

동작은 다음의 두 조건을 만족합니다: 

•  	이 장치는 간섭을 일으키지 않을 수 있으며, 

•  	이 장치는 장치의 바람직하지 못한 동작을 유발할 수 있는 간섭을 포함하는 어떤 간
섭도 수용할 수 있어야 합니다.
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인가된 서비스(예. 통합 채널 모바일 위성 시스템)로의 간섭을 막기 우해 이 장치는 실
내에서 사용해야 하며, 최대의 보호막을 제공하는 창으로부터 거리를 두어야 합니다. 
장치(또는 장치의 전송 안테나)가 실외에 설치된 경우에는 인증을 받아야 합니다. 

왜냐하면 높은 전력의 레이더는 5250~5350MHZ 대역의 주 사용자(우선순위를 의미
함)를 위해 고정 할당되어 인증되지 않은 LAN 장치에 간섭 및/또는 손상을 줄 수 있기 
때문입니다.

도메인 별 무선 작동 채널	
	

북미 2.412-2.462 GHz Ch01 through CH11

일본 2.412-2.484 GHz Ch01 through Ch14

유럽 ETSI 2.412-2.472 GHz Ch01 through Ch13

프랑스 내 제한 주파수 대역
프랑스의 일부 지역은 제한된 주파수 대역폭으로 사용이 제한됩니다. 가장 엄격한 곳
의 경우 실내에서 다음과 같이 사용이 가능합니다: 

•	 전체 2.4 GHz 대역에서 10mW (2400 MHz–2483.5 MHz) 

•	 2446.5 MHz~2483.5 MHz 대역 사이에서 100mW

참고: 채널 10~13은 2446.6MHz과 2483.5MHz 사이에서 작동합니다.

실외의 경우에는 예외가 있습니다. 사유 재산 또는 공적 사유 재산의 경우 국
방 장관에 의해 예비 승인 절차를 얻어 사용이 가능합니다. 최대 승인 전력은 
2446.5~2483.5MHz 사이에서 100mW입니다. 실외의 공공재산에서는 사용이 허가되
지 않았습니다: 

•	 실내 사용시, 최대 승인 전력: 100mW 

•	 실외 사용시, 최대 승인 전력: 10mW 

2400–2483.5MHz 대역의 범위에서 사용할 수 있는 장소는 실내의 경우 100mW 미만, 
실외의 경우 10mW 미만의 범위로 EIRP에서 허가했습니다:
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01 Ain Orientales 02 Aisne 03 Allier

08 Ardennes 09 Ariège 11 Aude

16 Charente 24 Dordogne 25 Doubs

32 Gers 36 Indre 37 Indre et Loire

45 Loiret 50  Manche 55  Meuse

59 Nord 60  Oise 61  Orne

64  Pyrénées Atlantique 66 Pyrénées 67  Bas Rhin

70  Haute Saône 71  Saône et Loire 75  Paris

84  Vaucluse 88  Vosges 89  Yonne

94  Val de Marne 41 Loir et Cher 82 Tarn et Garonne

05  Hautes Alpes 58 Nièvre 90 Territoire de Belfort

12 Aveyron 63  Puy du Dôme

26  Drôme 68  Haut Rhin

	

이 요구 사항은 시간이 지나면 프랑스의 더 많은 지역에서 무선 LAN 카드를 사용할 수 
있도록 완화될 것입니다. ART에서 최신 정보를 확인해 주십시오. (www.art-telecom.
fr) 

참고: 사용자의 WLAN 카드는 10mW 이상, 100mW 미만의 전파를 방출합니다.
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UL 안전 통보 
최대 200V peak, 300V peak to peak, 105V rms를 초과하지 않는 최저 작동 전압으로 
원거리 통신망에 접속하거나 국가 전력 코드(NFPA 70)에 의거하여 사용, 설치되는 원
격 통신(전화)에는 UL1459 규정이 요구됩니다.

UMPC 모뎀을 사용할 경우 발화, 전기 쇼크, 신체적 상해의 위험을 줄이기 위해 항상 
다음과 같은 기본 안전수칙을 준수해야 합니다:

•	 욕조, 세탁기, 부엌 싱크대, 세탁조, 습기가 많은 지하실, 수영장 등과 같은 물가 근
처에서 노트북 PC를 사용하지 마십시오. 

•	 번개를 동반한 폭풍시에는 노트북 PC를 사용하지 마십시오. 번개에 의한 전기 쇼크
의 위험이 발생할 수 있습니다.

•	 가스가 새는 곳에서 노트북 PC를 사용하지 마십시오.

제품에 전원으로 사용되는 주(충전 불가능), 보조(충전 가능) 리튬 배터리에는 UR1642 
규정이 요구됩니다. 이 배터리들은 화학 반응에 의해 화학 에너지를 전기 에너지로 바
꿀 수 있는 직렬 연결이나 병렬 연결, 혹은 복합 연결로 이뤄진 전기 화학 셀을 하나 이
상 포함하고 있습니다.

•	 폭발의 위험이 있으므로 UMPC의 배터리 팩을 불에 넣지 마십시오. 불 또는 폭발로 
인해 신체에 상해를 입지 않도록 배터리 폐기 방법을 지역 관할 사무소에 문의해 주
십시오.

•	 UMPC 제조회사나 인증된 대리점에서 공급하는 UL 인증 전원 어댑터나 배터리만을 
사용해 주십시오. 인증되지 않은 기타 전원 어댑터나 배터리를 사용하면 기계적인 
문제와 더불어 폭발의 위험을 야기할 수 있습니다.

안전 전력 요구량 
최대 6A의 전류, 3Kg 이상 무게의 제품은 다음과 동등하거나 그 이상의 사양을 가진 
인증된 전원 코드를 사용해야 합니다.

H05VV-F, 3G, 0.75mm2 or H05VV-F, 2G, 0.75mm2.
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북방 국가 경고 사항 (리튬 이온 배터리 사용 PC) 

CAUTION!  Danger of explosion if battery is incorrectly replaced. Replace only 
with the same or equivalent type recommended by the manufacturer. Dispose of 
used batteries according to the manufacturer’s instructions. (영어) 

ATTENZIONE! Rischio di esplosione della batteria se sostituita in modo errato. 
Sostituire la batteria con un una di tipo uguale o equivalente consigliata dalla 
fabbrica. Non disperdere le batterie nell’ambiente. (이탈리아어) 

VORSICHT! Explosionsgetahr bei unsachgemäßen Austausch der Batterie. Ersatz 
nur durch denselben oder einem vom Hersteller empfohlenem ähnlichen Typ. 
Entsorgung gebrauchter Batterien nach Angaben des Herstellers. (독일어)

ADVARSELI! Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering. Udskiftning 
må kun ske med batteri af samme fabrikat og type. Levér det brugte batteri 
tilbage til leverandøren. (덴마크어) 

VARNING! Explosionsfara vid felaktigt batteribyte. Använd samma batterityp eller en 
ekvivalent typ som rekommenderas av apparattillverkaren. Kassera använt batteri 
enligt fabrikantens instruktion. (스웨덴어) 

VAROITUS! Paristo voi räjähtää, jos se on virheellisesti asennettu. Vaihda paristo 
ainoastaan laitevalmistajan sousittelemaan tyyppiin. Hävitä käytetty paristo 
valmistagan ohjeiden mukaisesti. (핀란드어) 

ATTENTION!  Il y a danger d’explosion s’il y a remplacement incorrect de la 
batterie. Remplacer uniquement avec une batterie du mêre type ou d’un type 
équivalent recommandé par le constructeur. Mettre au rebut les batteries usagées 
conformément aux instructions du fabricant. (프랑스어) 

ADVARSEL! Eksplosjonsfare ved feilaktig skifte av batteri. Benytt samme 
batteritype eller en tilsvarende type anbefalt av apparatfabrikanten. Brukte 
batterier kasseres i henhold til fabrikantens instruksjoner. (노르웨이어) 

        
(일본어)
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ASUS 문의 정보

ASUSTeK COMPUTER INC. (아시아-태평양)
주소	 15 Li-Te Road, Peitou, Taipei, Taiwan 11259
웹사이트	 www.asus.com.tw

기술 지원
전화 지원	 +886228943447
팩스 지원	 +886228907698
소프트웨어 다운로드	 support.asus.com*

ASUS COMPUTER INTERNATIONAL (미국)
주소	 800 Corporate Way, Fremont, CA 94539, USA
전화	 +15107393777
Fax		 +15106084555
웹사이트	 usa.asus.com
소프트웨어 다운로드	 support.asus.com*

ASUS COMPUTER GmbH (독일 및 오스트리아)
주소	 Harkort Str. 25, D40880 Ratingen, Germany
전화	 +49210295990
Fax		 +492102959911
온라인 문의	 www.asus.com.de/sales

기술 지원
전화 지원	 +49210295990 
Fax		 +492102959911
온라인 지원	 www.asus.com.de/support
웹사이트	 www.asus.com.de/news

* 기술 지원을 문의하기 위해 기재해야 하는 기술 요청 양식을 이 사이트에서 찾을 수 있습니다.
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